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  
รูจักกับแตละสวนของ PowerPoint 2003 
 หลังจากเปดโปรแกรมข้ึนมาแลว  จะพบสวนประกอบของ PowerPoint 2003 ดังรูป 

 

 

 
 

 

แถบหัวเรื่อง เมนู แถบเครื่องมือ สไลด บานหนาตางงาน 

แถบเล่ือน แถบสถานะ ปุมเปล่ียนมุมมอง 

แถบหัวเรื่อง(Title Bar) คือ แถบแสดงช่ือโปรแกรม Microsoft PowerPoint รวมทัง้ชื่อไฟลที่เปดอยูใน

ขณะนั้น 

เมนู (Menu Bar)  คือ แถบที่ใชเก็บคําส่ังทั้งหมดที่ใชในโปรแกรม 

แถบเครื่องมือ (Toolbar) เปนแหลงที่เกบ็ปุมคําส่ัง โดยมากมายในแถบเคร่ืองมือนี้จะเก็บเฉพาะ

คําส่ังที่ใชบอย ๆ เพื่อใหสะดวกตอการใชงาน 

แถบเลื่อน (Scroll Bar) คือ แถบสําหรับเล่ือนดูแตละสวนของแผนสไลด ในกรณีทีห่นา

จอคอมพิวเตอรไมสามารถแสดงใหเหน็ทัง้หมดได 

บานหนาตางงาน (Task Pane) ในหนาตางนี้จะบรรจุคําส่ังที่จําเปนสําหรับงานทีท่ําอยูในปจจุบนั 
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วิธีสรางสไลดเบ้ืองตน 
 ถาตองการสรางงานนาํเสนอข้ึนมาใหม (ประกอบดวยสไลดหลาย ๆ แผน) PowerPoint 2003 มีวธิีการ

สรางงานนาํเสนออยู 3 วิธีคือ 
 วิธีที ่1 สรางงานนําเสนอดวยตัวชวยสรางอัตโนมัติ(AutoContent Wizard) 
 วิธีนีเ้หมาะสําหรับทานที่ไมคอยมีเวลามากนัก  การสรางงานนําเสนอวิธีนีเ้ปนวิธทีี่งาย  เพราะเพยีงเรา

บอก Power Point วาตองการนําเสนอเกี่ยวกับเร่ืองอะไร PowerPoint จะแนะนาํเคาโครงของการนาํเสนอมาให 

และยังกาํหนดวาสไลดแผนใดควรมีหัวขออะไรบาง  เราเพียงแกไขขอความบางสวนใหเหมาะสมกับงาน

นําเสนอของตนก็ใชไดเลย  แตไมคอยไดรับความนิยม  เพราะรูปแบบสไลดที่ออกมาจะไมตรงกับความตองการ

เทาที่ควร 

 วิธีสรางงานนาํเสนอจากตัวชวยสรางอัตโนมัติ มีรายละเอียดดังนี ้

 

                               
 

2 

1.  ใหเปดโปรแกรม PowerPoint 2003 ข้ึนมา เราจะพบบานหนาตาง Task Pane อยูทางขวามือ ของ   

โปรแกรม       

2.  คลิกที่  จากตัวชวยสรางอัตโนมัติ (From AutoConten wizard)  
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3 

 

3.  คลิกปุม  Next  เพื่อทําข้ันตอนตอไป 

 

4 

 
 

4.  คลิกเลือกประเภทของงานนําเสนอ เชน  เปนเร่ืองทัว่ ๆ ไป ใหคลิกปุม  General (ทั่วไป) หรือถาเปน 

     งานเกีย่วกบัโปรเจ็กต  ใหคลิกปุม Projects เปนตน 
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5.  คลิกเลือกชนิดงานนําเสนอ  ที่ตรงกับความตองการมากที่สุด 

6.  คลิกปุม  Next  เพื่อทําข้ันตอนตอไป จนจบกระบวนการ 

 

วิธีที่ 2  สรางงานนําเสนอจากแมแบบออกแบบ (Template) 
 Template หรือแมแบบ  หมายถงึ  ลักษณะเฉพาะของสไลดที่อยูในงานนาํเสนอนัน้ ไดแก สีหรือรูปที่

ใชกับพืน้สไลด สีของขอความในสไลด  รวมถงึการใชตัวอักษรภายในสไลด  ปกติลักษณะของแมแบบจะ

ถายทอดไปยังสไลดทุก ๆ แผนทีถู่กสรางข้ึนภายในงานนําเสนอนัน้ (นอกจากจะมีการเปล่ียนแปลงในภายหลัง) 

 สําหรับวธิีนี้จะคลายกับการสรางงานนาํเสนอดวยวิธี  ตัวชวยสรางเนื้อหาอัตโนมัติ แต PowerPoint 

ไมไดแนะนําเคาโครงงานนาํเสนอมาให  เราตองสรางสไลดทีละแผนและตองจัดการกําหนดหัวขอตาง ๆ ใน

สไลดเองทั้งหมด 

 วิธีสรางสไลดจาก Design Template (แมแบบออกแบบ)  มีข้ันตอนดังนี ้

 

3 

 
 

1.  เมื่อเปดโปรแกรม PowerPoint 2003 ข้ึนมา เราจะพบหนาตาง Task Pane อยูทางขวามือของโปรแกรม 

2.  คลิกที่  New presentation 

3. คลิกที ่ From design template เพื่อส่ังใหสรางงานนําเสนอใหมดวยการสรางจากรูปแบบที ่      

PowerPoint เตรียมไวให 
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4 

 
 

4.  คลิกเลือกรูปแบบสไลดที่ตองการ 

5.  ผลลัพธเราจะพบวา สไลดถูกเปลี่ยนไปตามแบบที่เลือก 

5 

 
 

6.  จากนั้น ตกแตงสไลดตามตองการ 
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วิธีที่  3  สรางงานนําเสนอดวยงานนําเสนอเปลา (Blank) 
 วิธีนีเ้หมาะสําหรับผูที่ตองการสรางงานนําเสนอดวยตนเองท้ังหมด  ไมตองการให PowerPoint แนะนํา

อะไรทั้งส้ิน เรียกวา  ตองการพึ่งลําแขงของตนเองเพยีงอยางเดียว  หากเลือกวิธนีี้เราจะตองทําอะไรหลายตอ

หลายอยาง เชน  ตองกาํหนดขอความในสไลดแตละแผน  ลักษณะพืน้สไลด  เลือกสีและขนาดตัวอักษรให

เหมาะสม ฯลฯ 

วิธีการสรางสไลดเปลา  มีข้ันตอนดังนี ้ 

 

 

2 

 
 

 

1.  เมื่อเปดโปรแกรม PowerPoint 2003 ใหคลิกที ่ New Presentation 

2.  คลิกที่  Blank  presentation 
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3 

 

3. คลิกเลือก Text Layouts   ซึ่งเคาโครงอัตโนมัตินี้จะเปนตัวกาํหนดวาควรวางอะไรไวสวนไหนของ

สไลด  สําหรับตัวอยางนี้คลิกเลือกเคาโครงที่มีแตขอความ 

 

4 
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4.  จะพบสไลดเปลาสีขาวมีกรอบเสนประอยู 2 สวน  ใหคลิก  ในกรอบดานบน  เพือ่พิมพขอความ กาํหนด

ชื่อเร่ือง  และคลิก  ในกรอบดานลาง  เพื่อพิมพขอความกําหนดเนื้อหาหรือช่ือเร่ืองรอง 

 
บรรจุฟอนตเขาไปในงานนําเสนอ 

 ในการสรางงานนําเสนอเพื่อนําเสนอกับคอมพิวเตอรหลายเคร่ือง  แตละเคร่ืองอาจติดต้ังฟอนตไม

เหมือนกนั ซึง่หากเคร่ืองทีน่าํเสนอไมมฟีอนตก็จะทําใหงานนําเสนอผิดพลาดได  เพื่อปองกนัปญหาดังกลาว  

เราจึงควรบรรจุฟอนตลงไปในงานนําเสนอเลย 

 ขอดีของการบรรจุฟอนตเขาไปในงานนาํเสนอคือ ไมวาเราจะนาํเสนอในเคร่ืองใด ๆ ก็ไมมีปญหาเร่ือง

ฟอนต แตขอเสียก็คือ  งานนําเสนอจะมีขนาดใหญข้ึน  เพราะตองรวมเอาฟอนตติดไปกับงานนาํเสนอดวย 

 

 

 

 

 

 

 วิธีการบรรจุฟอนตเขาไปในงานนาํเสนอ  มีข้ันตอนดังนีคื้อ 

 

 

1 

 

1.  เลือกเมนู  File > Save as…   
 
2.  บนแถบเครื่องมือ  ใหคลิกที่  Tools>Save Option 
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3.  คลิกใหมีเคร่ืองหมายถูกที่  แบบอักษร TrueTye  ฝงตัว 
 

 
5 

4 

3 

2 
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4.  เลือกวิธกีารบรรจุฟอนตลงในงานนาํเสนอ  ซึ่งมีอยู 2 แบบ คือ 

 -  บรรจุฟอนตเฉพาะที่ใชเพือ่ใหงานนําเสนอมีขนาดไมใหญเกนิไปนัก (Embed characters in use 

only) 

 -  บรรจุฟอนตทั้งหมดเพื่อใหสามารถแกไขงานนําเสนอไดทุกเมื่อ (Embed all characters) 

5.  คลิกปุม  Ok 
 

7 6 

 
 

6.  ต้ังชื่อไฟล 

7.  คลิกปุม  Save  เพื่อทาํการจัดเก็บไฟล นี ้
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เซฟ  PowerPoint  ในหลาย ๆ เวอรชัน 
 PowerPoint 2003  สามารถเลือกที่จะเซฟเพื่อใชงานกับเวอรชันเกาได ไมวาจะเปน PowerPoint 95, 

PowerPoint 97, PowerPoint 2000 หรือ PowerPoint XP  ทําใหเราสามารถสรางงานนําเสนอดวย 

PowerPoint 2003 และสามารถนําไปใชกบั PowerPoint  รุนเกา ๆ ไดโดยไมมีปญหา 

 วิธีการเซฟ  PowerPoint 2003  ใหสามารถใชกับรุนเกา ๆ ได มีข้ันตอนดังนี ้

 

1 

 
 

1.  เลือกเมนู   File > Save as… 

2.  ในชอง  Save  as  type   ใหเลือกวาจะเซฟงานนําเสนอในแบบใด  จากตัวอยางไดเลือกเปน         

PowerPoint 95   
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3 

4 

2 
 

 

 

3.  ต้ังช่ืองานนําเสนอ 

4.  คลิกปุม   Save 

5.  ผลลัพธเราจะไดงานนาํเสนอที่สามารถเปดใชงานไดจากโปรแกรม  PowerPoint 95  ตามตองการ 
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การแทรกรูปลงในสไลดและการใช Clip Art 
 ไฟลรูปภาพในปจจุบันมีอยูดวยกันหลายชนิด  ไมวาจะเปนไฟล .bmp, .jpg, .gif, หรือ .tiff ฯลฯ ไฟล

ภาพแตละแบบมีขอดีและขอเสียตางกันไป  เชน  ไฟล  .jpg  เปนไฟลภาพขนาดเล็กที่นยิมใชในอินเตอรเน็ต   

สวนไฟล  .tiff  เปนไฟลขนาดใหญที่ใชในวงการส่ือส่ิงพมิพ เปนตน 

 สําหรับ PowerPoint เปนโปรแกรมที่สนับสนุนไฟลภาพหลายประเภท  ซึง่ชวยใหเราสามารถเลือกใช

ภาพไดกวางขวาง ตอไปนี้เปนตัวอยางไฟลภาพที ่PowerPoint สนับสนนุ 

 

ชนิดไฟล นามสกุลไฟล 

Microsoft Windows Meta File .emf   .wmf 

Windows Bitmap .bmp   .dib   .rle 

Computer Graphics Meta File .cgm 

Graphics Interchange Format .gif 

Joint Photographic Experts Group .jpg 

Portable Network Graphics .png 

Macintosh PICT .pct 

Tagged Image File Format .tiff 

Vector Markup Language .vml 

Microsoft Windows Media .avi   .asf   .asx   .rmi   .wma   .wax   .wav 
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วิธีแทรกรูปลงในสไลด 
 รูปภาพเปน  Object  ประเภทหนึ่งที่นยิมในลงไปในสไลด  เนื่องจากชวยใหสไลดดูสวยงาม ส่ือ

ความหมายไดดี หรือในบางกรณีที่เปนภาพการตูนก็ขําขันก็ได 

 วิธีการแทรกรูปภาพลงในสไลดมีข้ันตอนดังนี ้

 

1 

 
 

1.  เลือกเมนู   Insert>Picture >From File 
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2.  เลือกโฟลเดอรซึ่งเก็บไฟลรูปภาพที่ตองการไว  จากตัวอยางเก็บไวที่โฟลเดอร My picture 

 

 

3 

4 

2 

 

 

3.  คลิกเลือกรูปภาพที่ตองการ 

4.  คลิกปุม  Insert   เพื่อแทรกรูปลงสไลด 
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5 

 

 

5.  ผลลัพธจะปรากฏรูปภาพในสไลด  จากน้ันใหคุณปรับแตงภาพไดตามตองการ เชน  ลดขนาดภาพลง หรือ 

ยายไปตําแหนงตาง ๆ ในสไลด เปนตน 

 

 

การใสขอความสไลดในกลองขอความ (Textbox) 
 การกรอกขอความลงไปในสไลดทําไดหลายวิธ ีวิธทีี่สะดวกที่สุดคือการพิมพขอความลงในกลอง

ขอความ (Textbox) และ กรอกขอความใน Place holder ที่มีมาใหต้ังแตตอนเปดโปรแกรม 

 การกรอกขอความในกลองขอความ มีข้ันตอนดังนี้คือ 

 

 

1 

 

1.  คลิกปุม  Text  Box  ซึง่อยูดานลางของโปรแกรม 

2.  คลิกภายในสไลดในตําแหนงที่ตองการกรอกขอความ 
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2 

 

3.  กรอกขอความตามตองการ  และหากตองการขึ้นบรรทัดใหมใหกดปุม  Enter 

4.  ถาตองการออกจากการทาํงานกับกลองขอความ  ใหคลิกบริเวณทีว่างอ่ืน ๆ ในสไลด หรือใชวิธกีดปุม Esc 

2 คร้ังก็ได 

 

 

 

 

การใส WordArt  ลงในสไลด 
 WordArt หรือโปรแกรมอักษรศิลป  เปนรูปแบบอักษรสําเร็จรูปที่ถูกออกแบบมาอยางดี  มหีลาย

รูปแบบใหเลือกใชงาน  และเปนอักษรชนดิพิเศษ  จึงไมมีคุณสมบัติเกีย่วกับการตรวจสอบคําผิด   ดังนัน้ การ

กรอกขอความโดยใช  WordArt  ผูใชตองระวังเปนพิเศษ  เพราะเราตองตรวจสอบคําผิดและความตองเอง 

 วิธีใส  WordArt ลงในสไลด 

 

 

1 

 

1.  คลิกปุม  WordArt   จะพบอักษรศิลปรูปแบบตาง ๆ มากมาย 

2.  คลิกเลือกรูปแบบที่ตองการ 
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 3 

2 

 

3.  คลิกปุม  Ok 
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ระบบมัลติมีเดียในสไลด 
 

การแทรกไฟลเสียงเพลงจาก  MP3   WMA  และอ่ืน ๆ 
 
 ไฟลเสียงประเภทหนึ่งที่นยิมนํามาใชประกอบในงานนําเสนอคือ  ไฟล  MP3 และไฟล  WMA ขอดีของ

ไฟลประเภทนีคื้อมีขนาดเล็ก  แตใหคุณภาพเสียงที่ใกลเคียงกับตนฉบับมาก 

 วิธีแทรกไฟลเสียงเพลงลงไปในสไลดใหทาํตามข้ันตอนดังนี ้

 

 
 

1.  เลือกเมนู  Insert > Movie and Sound  > Sound from file 

 

 

 

 

 

 

 

 



 21

 

 

2.  คลิกเลือกไฟล MP3  หรือไฟล  WMA  ที่ตองการ 

 

 
 

3.  คลิกปุม  OK 

4.  จะปรากฏขอความข้ึนมา  ใหคลิกปุม  Automatically  หากตองการเลนไฟลเสียงอัตโนมัติเมื่อเปดสไลด  แต

ถาคลิกปุม  When Clicked  เปนการส่ังใหเลนไฟลเสียงหลังจากคลิกเมาส 

 

 

3 

4 

2 

 

5.  จะปรากฏไอคอนรูปลําโพงในสไลด  ทดลองฟงเสียงดวยการ  ดับเบ้ิลคลิก ที่ไอคอนน้ี  และคลิกอีกคร้ังเพื่อ

หยุดเลน 
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6.  เลือกเมนู  Slide Show  > Custom Animation…. 

 

 

5 

6

 

7.  คลิกที่ไฟลเสียงเพลง 

8.  คลิกลูกศรดานขาง  แลวคลิกเลือก  Effect  Options…..  เพื่อปรับแตงไฟลเสียงเพลงนี ้

 

8 
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9.  กาํหนดวาจะใหเลนเพลงในทอนใด  ซึง่มีรายละเอียดดังนี ้

ง 

หยุดไวคร้ังสดุทาย 

นิาที เชน  00:02 

 

0.  กาํหนดวาจะใหหยุดเพลงเมื่อใด  ซึ่งมีรายละเอียด ดังนี ้

 

ลี่ยนแผนสไลด 

หนด เชน  หากกาํหนด

 -  from beginning   หมายถงึ  ส่ังใหเลนต้ังแตตนเพล

 -  from last position หมายถึง  ส่ังใหเลนตอในทอนที่ได

 -  from time หมายถงึ  ใหเร่ิมเลนในทอนที่ไดกําหนด  โดยระบุเปน  นาท ี: ว

หมายถงึวนิาทีที ่2 

 

9 

10 

1

 -  On click    หมายถงึ  ส่ังใหหยุดเพลงเมือ่มีการคลิกเมาส

 -  After current slide หมายถึง ส่ังใหหยดุเพลง  เมื่อมกีารเป

 -  After slide  หมายถึง ส่ังหยุดเพลงหลังจากเปล่ียนแผนสไลดไปยังแผนทีก่ํา

เปน 7  หมายถึง เพลงนี้จะเลนไปเร่ือย ๆ จนถงึสไลดแผนที ่7  เมื่อสไลดแผนที่ 8 เขามาเพลงจึงจะหยุดเลน 
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11.  คลิกแทบ  Timing 

 

 

2.  ในชอง Repeat   เปนการกําหนดวาจะวนเพลงซํ้าไปกี่รอบ 

 

 

11 

1

13.  คลิกปุม  Ok 

 

 

 

 

 

 

 

 

 

 

12 

13 
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การฝงไฟลเสียงหรือเชื่อมไฟลเสียงในสไลด 
ักจะไมฝงไฟลเสียงลงไปในสไลด  ซึ่งจะเปนปญหาเวลาไป

ดเคร่ือ

ยปกติ  PowerPoint   จะตรวจสอบขนาดไฟลเสียง   วามีขนาดเปนเทาใด  หากเปนไฟลเล็ก ๆ ก็จะ

งมันลง  

 

.  เลือกเมนู  Tools > Option 

 

 การใสเสียงลงไปในสไลด  PowerPoint  ม

เป งอ่ืนแลวเสียงไมม ี เพราะขนาดไฟลเสียงทัว่ไปมักเปนเปนไฟลขนาดใหญ  เปนผลใหงานนําเสนอมี

ขนาดใหญตามไปดวย  ดวยเหตุนี ้ PowerPoint  จะใชวธิีอางอิงไฟลเสียงแทนการผนึกไฟลลงไปในงาน

นําเสนอ 

 โด

ฝ ไปในสไลด  แตหากเปนไฟลใหญจะใชวิธีเชื่อมโยงแทน    ดังนัน้  เราจึงตองเขาไปกําหนดใน  ตัวเลือก

(Options)  ใหขนาดไฟลเสียงมีคามากที่สุด เพื่อใหไฟลเสียงถกูฝงลงไปในสไลด 

 

1 

 

1

2.  คลิกแทบ  Genaral 
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2 

4 

3 

 

3.  กาํหนดขนาดไฟลเสียงสูงสุด  หากไฟลเสียงมีขนาดใหญกวานีจ้ะใชวิธีเชื่อมโยงแทน  ถาคุณตองการฝงไฟล

เพลงลงในงานนาํเสนอ  ควรกําหนดใหขนาดไฟลใหญข้ึน เชน 20000 KB เปนตน 

4.  คลิกปุม  Ok 
 
 

การแทรกไฟลวีดีโอและภาพยนตร 
 หากตองการแทรกไฟลวีดีโอหรือไฟลภาพยนตรลงไปในสไลด  ก็สามารถทําได โดย PowerPoint นั้น

สนับสนนุไฟลวีดีโอหลายอยาง เชน  ไฟล AVI,  ไฟล MPEG และ ไฟล Windows Media Video(WMV) 

                           ตอไปนี้เปนตัวอยางการแทรกไฟล  AVI   

 

 

1 
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1.  เลือกเมนู   > Movie and Sound > Movie from file 

2.  เลือกไฟลวดีีโอที่ตองการ 

 

3 

2 

 
 

3.  คลิกปุม  Ok 

4.  จะปรากฏขอความข้ึนมา  ใหคลิกปุม     หากตองการเลนวีดีโออัตโนมัติเมื่อเปดสไลด  แตถา คลิกปุม  

ไมใช   จะเปนการส่ังใหเลนวีดีโอหลังจากคลิกเมาส 

5.  กดปุม  <F5>   เพื่อทดลองดูไฟลวีดีโอในสไลดสวนการปรับแตงนั้นจะคลายกับการปรับแตงไฟลเสียงดังที่

ไดกลาวมาแลว 

 
หมายเหตุ -   เทคนิคในการเช่ือมโยงไฟลภาพยนตขนาดใหญ  ใหสามารถเปดไดทกุเคร่ืองคือ ใหคัดลอกไฟล

ภาพยนตและไฟลPowerPoint(.ppt)ใหอยูในโฟลเดอรเดียวกนั   ซึ่งจะทําPowerPointสามารถเช่ือมโยงไฟล

ภาพยนตรที่มขีนาดใหญใหโดยอัตโนมัติ 
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ลูกเลนท่ีใชในขณะนําเสนอ 

 
ชนิดของลูกเลน Animation และ Transition 
 สําหรับ PowerPoint 2003 สามารถสรางลูกเลนหรือเทคนิคในการนําเสนอสไลดได 2 แบบ ดัง

รายละเอียดตอไปนี้ 

 Animation 
 Animation  อานวา  แอนิเมชัน  เปนลูกเลนที่ใสใหกับขอความ รูปภาพ กราฟ ตาราง หรือส่ิงอื่น ๆ ที่อยู

ในสไลด ตัวอยางเชน  เมื่อเราเปดสไลดข้ึนมา  เราอาจเห็นขอความวิง่ออกมาจากดานซายของสไลด หรือวิง่มา

ทีละตัวจากดานขวา   

 ส่ิงทีพ่ิเศษสําหรับ PowerPoint 2003 คือ เราสามารถกําหนดลูกเลนใหกับกราฟหรือไดอะแกรมได เชน 

กําหนดใหกราฟปรากฏข้ึนมาทีละแทง  หรือส่ังใหไดอะแกรมปรากฏทลีะชิ้น เปนตน  นอกจากนีเ้รายังสามารถ

กํากับใหขอความวิง่มากอน รูปภาพวิง่ตามมา  หรือสลับกันตามชวงจังหวะเวลาทีผู่ใชเปนผูกาํหนดเองได 

 Transition 
 Transiton  อานวา  ทรานซิชนั  เปนลูกเลนที่ถูกแสดงในการเปล่ียนแผนสไลด  ตัวอยางเชน  เมื่อสไลด

แผนที่แลวหายไป  สไลดแผนตอไปจะปรากฏข้ึนมาโดยวิง่แบบรวดเร็วจากทางซาย  หรือคอย ๆ ปรากฎเปน

ภาพสลัว ๆ  แลวคอย ๆ ชัดข้ึน  หรือเปนภาพตารางหมากรุกกอนจงึคอยเหน็เปนภาพสไลดทั้งหมด 

 PowerPoint 2003 ไดปรับปรุง Transition เปนรุนใหม  มใีหเราเลือกใชหลายแบบ  นอกจากนี้ผูใชยงั

สามารถใสเสียงประกอบในขณะเปล่ียนสไลดไดดวย  ไมวาจะเปนเสียงที่มีใน PowerPoint หรือเสียงที่ผูใช

เตรียมมาเอง 
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กําหนดและปรับแตง Animation ใหกบัขอความ 
 วิธีกาํหนด Animation ใหกบัขอความดวยตนเอง มีดังนี ้

 

2 

1 

 
 

1.  คลิกภายในขอความที่ตองการใสลูกเลน 

2.  เลือกเมนู  Slide  Show > Custom Animation…. 

3.  คลิกปุม  Add Effect   แลวเลือกเมนู  Entrance เลือกลูกเลนขณะที่ขอความเขามาในสไลด 

 

                        
 

3
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4.  คลิกเลือกลูกเลนที่ตองการ  จะพบภาพตัวอยางลูกเลนในสไลด 

นขณะแสดงขอความอยูในสไลด โดย

 

.  คลิกเลือกลูกเลนที่ตองการ 

ลือก  Exit  กาํหนดขอความออกไปจากสไลด 

 

.  คลิกเลือกลูกเลนที่ตองการ 

ปรากฎในรายการ  ซึ่งจะเรียงตามลาํดับกอนหลัง 

5.  คลิกปุม  Add Effect   แลวคลิกเลือก Emphasis  เพื่อกําหนดลูกเล

ผูนําเสนอจะตองคลิกเมาส เพื่อส่ังใหแสดงลูกเลน 

 

6

7.  คลิกปุม  Add Effect   แลวเ

 

8

9.  เราจะเห็นลูกเลนทั้งสามแบบ

5 

7 
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9

10

 
 

10.  ทดสอบลูกเลนทั้งหมด  โดยการคลิกปุม Play   โปรแกรม  PowerPoint จะแสดงลูกเลนที่ไดกาํหนดไวกับ

ขอความออกมาทัง้หมด 
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การแกไขปรับแตง Animation ใหกับขอความ 
  การใสลูกเลนใหกับขอความ สามารถส่ังใหมีผลกับขอความทีละตัวอักษร  ทีละคํา หรือทั้งหมด 

ตัวอยางเชน ส่ังใหตัวอักษรตกมาจากดานบนทีละตัว  หรือวิ่งมาจากทางซายทีละคํา  ดังตัวอยางตอไปนี้ 

 

 

2 

1 

 

1.  คลิกภายในขอความ ที่ตองการปรับแตงลูกเลน 

2.  เลือกเมนู   SlideShow>Costom Animation 

3.  คลิกเลือกรายการลูกเลนที่ตองการแกไข 

4.  คลิกลูกศรแลวคลิกเลือก  Effect Option 

 

4 
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5.  คลิกแท็บ  Effect 

 

9
8 

7 

6 

5 

6.  ปรับแตงรายละเอียดใหกับลูกเลน เชน  Smooth  Start  หมายถงึ กําหนดใหเร่ิมแสดงลูกเลนอยางราบร่ืน

และตอเนื่อง  เปนตน 

7.  กาํหนดเสียงที่ใชขณะแสดงลูกเลน  โดย PowerPoint ไดจัดเตรียมเสียงมาใหพอสมควร 

8.  กําหนดวาจะใหแสดงขอความทีละตัวอักษร  ทีละคํา  หรือทัง้หมด 

 -  All at once   หมายถงึ  แสดงขอความทุก ๆ หวัขอในคร้ังเดียว 

 -  By word  หมายถงึ  แสดงขอความออกมาทีละคํา 

 -  By latter  หมายถงึ  แสดงขอความปรากฏขึ้นมาทีละตัวอักษร 

9.  คลิกปุม  Ok 

10.  ทดลองนาํเสนอ  ดวยการกดปุม <F5>   จะเหน็ผลลัพธการแสดงตัวอักษร 
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กําหนดและปรับแตง Animation ใหกบัรูปภาพ 
 การกําหนดลูกเลนใหกับภาพ  มีลักษณะเดียวกับขอความ  สามารถกาํหนดลูกเลนขณะรูปเขามาใน

สไลด  ขณะอยูในสไลด และขณะออกไปจากสไลด  และสามารถกําหนดเสียงขณะแสดงลูกเลน  ดังตัวอยาง

ตอไปนี้ 

 

2 

1 

1.  คลิกรูปที่ตองการใสลูกเลน 

2.  เลือกเมนู Slide Show>Costom animation…. 

 3.  คลิกปุม  Add Effect   แลวคลิกเลือก  Entrance  เพื่อเลือกลูกเลนขณะที่รูปภาพเขามาในสไลด 
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4

3 

 

4.  คลิกเลือก  More Effect   เพื่อเลือกลูกเลนอ่ืน ๆ เพิม่เติม  จะปรากฏรายการลูกเลนใหเลือกอีกมากมาย 

5.  คลิกเลือกลูกเลนที่ตองการ 

 

 

 

5 
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6.  ดูตัวอยางลูกเลนในสไลด  จะเห็นรูปภาพแสดงในแบบที่ไดเลือกไว 

7.  คลิกปุม  Ok 

กําหนด  Transiton ขณะเปลี่ยนสไลด 
 เทคนิคหนึง่ทีท่ําใหงานนําเสนอดูเปนมืออาชีพคือ การใสลูกเลนในขณะเปล่ียนแผนสไลดจากแผนหนึ่ง

ไปยังอีกแผนหนึง่  เราเรียกลูกเลนในขณะเปล่ียนแผนสไลดนี้วา  Transition (อานวา ทรานซิชนั) 

 

 
 

1.  คลิกสไลดแผนที่ตองการ  หากตองการเลือกหลายแผนพรอมกนั ใหกดปุม <Ctrl> ขณะคลิกเลือกสไลด 

2.  เลือกเมนู  Slide Show > Slide Transition (นําเสนอภาพน่ิง > การเปลี่ยนภาพน่ิง) 

2 

1 

6 
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7 

3 

4 
5

6

3.  เลือกรูปแบบของลูกเลนที่ตองการ 

4.  ระบุความเร็วในการแสดงลูกเลน ซึง่มอียูดวยกัน 3 ระดับคือ   Slow Mediem Fast   

5.  กาํหนดเสียงประกอบ  ในขณะเปล่ียนสไลด  หากคลิกเลือก  Loop Until next sound (วนรอบจนถึงเสยีง

ถัดไป)  หมายถึง ส่ังใหเลนเสียงไปเร่ือย ๆ จนกวาจะมเีสียงอ่ืน 

6.  ระบุวิธีการเปล่ียนสไลด  ดังนี ้

หมายถึง  เปล่ียนสไลดก็ตอเม่ือเราคลิกเมาส  -  On mouse click   

 -  Automatically  หมายถึง ใหเปล่ียนสไลดอัตโนมัติตามเวลาทีก่ําหนด  ซึง่หากเลือกเปน  00:04  

หมายถงึ  4 วนิาท ี

 

7.  หากตองการใหมีผลตอสไลดทุก ๆ แผน ใหคลิกปุม  Apply to All Slides 

8.  คลิกปุม  Play เพื่อดูตัวอยางลูกเลนในการเปล่ียนสไลด  หรือถาตองการจะทดลองนาํเสนอจริง ใหคลิกปุม  
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การกําหนดลูกเลนใหกบักราฟ 
 เราสามารถใสลูกเลนใหกับกราฟ ไดเชนเดียวกับรูปภาพ  อาท ิ ส่ังใหแทงกราฟวิ่งมาทีละแทง  หรือ

หมุนเขามาทีละชุดก็ได 

 

 

1

 

1.  คลิกขวาทีก่ราฟที่ตองการกําหนดลูกเลน (ในตัวอยางเปนกราฟแทง)  จากนัน้เลือก เมน ู   
CostomAnimation 
2.  คลิกปุม  Add Effect 
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2

3

 

3.  เลือกรูปแบบลูกเลน  จากตัวอยางเลือก  Entrance> wipe  

4.  คลิกลูกศรขางรายการลูกเลน  จากนั้นคลิกเลือก  Effect  Option 
 

        
 

 

 

5.  คลิกแท็บ  Chart  Animation 

6.  ในชอง  Group Chart    เลือกวาจะแสดงลูกเลนใหกบักราฟสวนใด  ซีง่มีรายละเอียด คือ 

5 
6 

4 
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 -  As One Object   กาํหนดใหกราฟแสดงเปนสวนเดียวทัง้หมด 

 -  โดยชุด  กาํหนดใหแสดงกราฟทีละชุดของขอมูล 

 -  โดยประเภท  กาํหนดใหแสดงกราฟทลีะประเภทของขอมูล 

 -  โดยองคประกอบในชุด  กาํหนดใหแสดงกราฟทีละสวนภายในชดุขอมูล 

 -  โดยองคประกอบในประเภท  กําหนดใหแสดงกราฟทีละสวนภายในประเภทขอมูล 

7.  คลิกแท็บ  Effect 
 

 
 

.  เลือกทิศทางวาจะใหกราฟวิ่งมาจากทางใด  โดยเลือกทเศทางที่ตองการ  สําหรับตัวอยางเลือก จาก
านขวา 

 

7

 

8
ด
9.  เลือกเสียงจากรายการ  Sound
 
 

 

 

 

 

 

8 

9 
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10.  คลิกแท็บ  การกาํหนดเวลา 
 

มเร็วในการแสดงแทงกราฟ ตามตองการ 

2.  เมื่อเสร็จแลวใหคลิกปุม  Ok 

 

 

 

 

 

 
 

10

11

12

11.  ในชอง  Speed   ใหกาํหนดควา

1
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การอัดเสียงพูดประกอบการนําเสนอ 

 ในการนําเสนอหากตองการใชความสามารถ  PowerPoint อยางเต็มที่  ควรนาํเสนอผานเคร่ือง

คอมพิวเตอร เพราะวาสามารถบรรยายและคลิกเลือกตัวเลือกตาง ๆ ไดเองทัง้หมด 

 แตในบางกรณีที่ผูบรรยายไมอยู ติดภารกิจสําคัญ  งานนําเสนออาจจําเปนตองถูกยกเลิกไป  ปญหา

ดังกลาว สามารถแกไขได โดยการอัดเสียงพูดแทนการบรรยายจริง 

 

rd Narration 

.  เราจะพบหนาตางแสดงขอความบอกวา  จะสามารถบันทึกเสียงไดนานก่ีนาที มีเนื้อที่ในดิสกเพียงพอ

รือไม 

 
.  คลิกปุม  Set  Microphone Level 

.  ใหทดลองพูดใสไมโครโฟน  โดยใหอานขอความในกลองขอความ  จะปรากฏแถบเล่ือนเปนสีแดง

สัญญาณเสียงทีพู่ด  หากไมมีการเ โครโฟนไมถูกตอง หรือมีปญหา

เกี่ยวกับการดเสียงอยางใดอยางหนึ่ง 

 
ของ

 

1.  เลือกเมนู  Slide show >Reco

คลื่อนไหวของแถบเล่ือน  นัน่แสดงวา ตอไม

1 

2

ห 6 

2

3

3

 

4
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5.  คลิกปุม  Ok 

6.  คลิกปุม  Ok  เพื่อเร่ิมอัดเสียงบรรยาย 

7.  มาถงึตอนนี้  PoserPoint  จะนาํเสนอในมุมมองนําเสนอภาพนิ่งทนัที  ใหผูอานพดูบรรยายใสในไมโครโฟน

ไดทันท ี เมื่อบรรยายเสร็จแลวใหกดปุม  Enter  เพื่อเปล่ียนแผนสไลด 

.  เมื่อมาถึงสไลดแผนสุดทายจะมีขอความถามวาจะเซฟเวลาที่กําหนดใหในแตละสไลดหรือไม  ใหคลิกปุม 

 

 

 

 

 

 

 

 

 

4 

5

8
Save 
9.  ทดลองนําเสนอโดยกดปุม  <F5>  ผลลัพธจะมีเสียงประกอบในแตละสไลดตามที่ไดอัดเสียงไว 

 

 

 

 

 

 



 44

การเก็บงานนําเสนอลงแผนซีดี 
 

 เม ไดสรางงานนําเสนอเสร็จเรียบรอยแลว  สามารถเก็บงานนําเสนอลงแผนซีดีได  ซึ่งมีข้ันตอน

ดังนี ้ (มีเฉพาะใน PowerPoint เวอรชัน 2003) 

1.  เปดงานนาํเสนอที่ตองการข้ึนมา 

2.  เลือกเมนู  File >Package  For  Cd 

3.  ต้ังชื่อแผน ซีดี 

4.  ถางานนาํเสนอที่ใชมหีลายไฟล  ใหคลิกปุม   Add  file … เพื่อเพิม่งานนาํเสนออื่นเพิม่เติม 

5.  คลิกปุม  Option 

ใหมีการเลนไฟลนาํเสนอในแบบใด  ซึง่มีรายละเอียด ดังนี ้

tically in the specified order  เปนการส่ังใหเลนงานนําเสนอ

เลนงานนําเสนอชิน้แรกอัตโนมัติ  

-   Don’t  play the Cd automatically หมายถงึ  ไมตองการใหมีการเรียกโปรแกรม  หรือเปดงาน

ําเสนอใด ๆ โดยอัตโนมัติ 

.  คลิกใหมีเคร่ืองหมายถูกหนา   แบบอักษรฝงตัวแบบ True Type     เพื่อใหมีการกอปปฟอนตลงไปใน

ผนซีดีดวย  ปองกนัปญหาที่วาเคร่ืองที่ใชนําเสนอไมมฟีอนตดังกลาวติดต้ังอยู 

.  สามารถใส  รหสัผานปองกันไมใหผูอ่ืนเปดงานนาํเสนอ      และ  รหัสผานปองกันไมใหผูอ่ืนแกไข

านนําเสนอ   โดยกรอกรหัสผานลงไป หรือจะไมใสกไ็ด 

.  คลิกปุม  Ok 

0.  คลิกปุม  Choppy  to  CD    เพื่อทาํการเขียนขอมลูลงแผน 

1.  หลังจากเขียนเสร็จจะมขีอความถามวา ตองการจะคัดลอกงานนาํเสนอนี้ไปยังแผนซีดีอ่ืนอีกหรือไม  ให

ลิกปุม  No   เพราะไมตองการเขียนลงแผนอ่ืนอีก 

2.  คลิกปุม Close   เปนอันเสร็จส้ินข้ันตอน 

ื่อเรา

6.  กาํหนดวา  จะ

 -  Play all presentation automa

อัตโนมัติทนัทเีมื่อใสแผนซีดี  โดยจะเลนงานนาํเสนอทุก ๆ ไฟล  ตามลาํดับกอนหลัง 

 - Play only first presentation automatically หมายถงึ  ส่ังให

หลังจากใสแผนซีดีลงไป และเมื่อเลนเสร็จจะปรากฏหนาตางใหเราเลือกงานนําเสนอที่จะเลนในลําดับตอไป 

 -  Don’t  play the Cd automatically  หมายถงึ  เมื่อเราใสแผนซีดีลงใน CD-ROM   จะปรากฏ

หนาตางใหเราเลือกงานนําเสนอที่ตองการเลน 

 

น

7

แ

8

ง

9

1

1

ค

1
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การใชงานแผนซีดีงานนําเสนอ 
 ปกติแผนซีดีทีส่รางจาก  PowerPoint  จะเปนซีดีในระบบอัตโนมัติ  กลาวคือ เมื่อนําแผนซีดีใสลงใน 

ซดีี

เปนการเลือกไฟลในขณะใสแผน CD ดวย  ซึ่งถาหากวาเลือก

ชงานดังนี ้

OM ไดรว 

ถูกเปดข้ึนมาโดยอัตโนมัติทันท ี 

CD-ROM   งานนําเสนอจะถูกเปดข้ึนมาอัตโนมัติ  แตทั้งนี้ก็ข้ึนอยูกบัการกําหนดไวในข้ันตอนการสรางแผน

นําเสนอวาจะเปนการเปดแบบอัตโนมัติ  หรือจะ

เปนแบบอัตโนมัติ  ก็จะมีข้ันตอนการใ

1.  ใสแผน ซีดี งานนําเสนอลงไปใน CD-R

2.  งานนาํเสนอจะ

 

 

ฟอนตท่ีควรเลือกใชในการทําส่ือ PPT 

• Tahoma ซ่ึงใชไดท้ังภาษาไทย และภาษาอังกฤษ เนื่องจากมีขนาดตัวอักษรท่ีมองเห็นไดชัดเจน มี

mic MS ก็เปนฟอนตท่ีนาสนใจเชนกัน  
• 

****************************************************************** 

ชองวางท่ีเหมาะสม  
• Verdana สําหรับการทํา Title ภาษาอังกฤษ  
• Aria สําหรับการแสดงผลเน้ือหาภาษาอังกฤษ  
• กรณีท่ีทําสไลดสําหรับเด็กๆ ฟอนต Co

อยางไรก็ตามควรหลีกเล่ียงการใช Times New Roman  

 

 

 

 

 

 

 

 


